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Getting started with STM32CubeWB for STM32WB Series

Introduction

STM32Cube™ is an STMicroelectronics original initiative to make developers’ lives easier
by reducing development effort, time and cost. STM32Cube™ covers the whole STM32
portfolio.

STM32Cube™ includes:

e  STM32CubeMX, a graphical software configuration tool that allows the generation of C
initialization code using graphical wizards.
e A comprehensive embedded software platform, delivered per Series (such as

STM32CubeWB for STM32WB Series):

—  The STM32Cube™ HAL, STM32 abstraction layer embedded software ensuring
maximized portability across STM32 portfolio. The HAL is available for all
peripherals

— Low-layer APIs (LL) offering a fast light-weight expert-oriented layer which is
closer to the hardware than the HAL. LL APlIs are available only for a set of
peripherals.

— A consistent set of middleware components such as USB Device, STMTouch
(STM32 touch sensing library), STM32_WPAN (Bluetooth® Low Energy 5.0,
OpenThread, 802-15-4 MAC), FatFS and FreeRTOS.

—  All embedded software utilities coming with a full set of examples.
This user manual describes how to get started with the STM32CubeWB MCU Package.
Section 1 describes the main features of the STM32CubeWB MCU Package.

Section 2 and Section 3 provide an overview of the STM32CubeWB architecture and MCU
Package structure.
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1 STM32CubeWB main features

The STM32CubeWB MCU Package runs on STM32 32-bit microcontrollers based on the
Arm®@) Cortex®-M processor.

STM32CubeWB gathers, in a single package, all the generic embedded software
components required to develop an application on STM32WB microcontrollers. In line with
the STM32Cube™ initiative, this set of components is highly portable, not only within
STM32WB Series but also to other STM32 Series.

STM32CubeWB is fully compatible with STM32CubeMX code generator that allows
generating initialization code. The package includes low-layer (LL) and hardware
abstraction layer (HAL) APIs that cover the microcontroller hardware, together with an
extensive set of examples running on STMicroelectronics boards. The HAL and LL APlIs are
available in open-source BSD license for user convenience.

STM32CubeWB MCU Package also contains a set of middleware components with the
corresponding examples. They come in free user-friendly license terms:

e CMSIS-RTOS implementation with FreeRTOS™ open source solution

e  Full USB Device stack supporting many classes: Audio, HID, MSC, CDC and DFU
e  STMTouch, touch sensing library solution

e STM32_WPAN, wireless personal area network middleware developed within the
STM32WB framework to support Bluetooth® Low Energy (BLE) 5.0, 802.15.4
OpenThread certified stacks and 802-15-4 MAC layer.

e  FAT file system based on open source FatFS solution

Several applications and demonstrations implementing all these middleware components
are also provided in the STM32CubeWB MCU Package.

€3 Bluetooth *HREAD arm

a. Arm is a registered trademark of Arm Limited (or its subsidiaries) in the US and or elsewhere.
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Figure 1. STM32CubeWB firmware components
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(1) The set of middleware components depends on the product Series. MSv46868V1
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2 STM32CubeWB architecture overview

The STM32CubeWB firmware solution is built around three independent levels that easily
interact as described in Figure 2.

Figure 2. STM32CubeWB firmware architecture

Level 2 Evaluation board, Nucleo and Discovery Kit demonstrations

Applications

Level 1

Library and protocol based components
(for example FatFS, USB, STMTouch, FreeRTOS™ or
STM32_WPAN)

Examples

11

Level 0 <:] BSP drivers
Hardware abstraction layer (HAL)
Core drivers (optional) Low-layer (LL)
HAL
MSv61375V1
2.1 Level 0

This level is divided into three sub-layers:
e Board support package (BSP)
e Hardware abstraction layer (HAL)
—  HAL peripheral drivers
—  Low-layer drivers
e Basic peripheral usage examples

3
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211 Board support package (BSP)
This layer offers a set of APlIs relative to the hardware components in the hardware boards
(such as LCD, Audio, microSD™ and MEMS drivers). It is composed of two parts:
e  Component
This is the driver relative to the external device on the board and not to the STM32. The
component driver provide specific APIs to the BSP driver external components and
could be portable on any other board.
e BSP driver
It allows linking the component driver to a specific board and provides a set of user-
friendly APIs. The API naming rule is BSP_FUNCT_Action().
Example: BSP_LED_Init(), BSP_LED_On()
The BSP is based on a modular architecture allowing an easy porting on any hardware by
just implementing the low-level routines.
21.2 Hardware abstraction layer (HAL) and low-layer (LL)

3

The STM32CubeWB HAL and LL are complementary and cover a wide range of
applications requirements:

The HAL drivers offer high-level function-oriented highly-portable APIs. They hide the
MCU and peripheral complexity to end user.

The HAL drivers provide generic multi-instance feature-oriented APIs which simplify
user application implementation by providing ready to use process. As example, for the
communication peripherals (12S, UART, and others), it provides APls allowing
initializing and configuring the peripheral, managing data transfer based on polling,
interrupt or DMA process, and handling communication errors that may raise during
communication. The HAL driver APIs are split in two categories:

—  Generic APIs which provides common and generic functions to all the STM32
Series

—  Extension APIls which provides specific and customized functions for a specific
family or a specific part number.

The low-layer APIs provide low-level APls at register level, with better optimization but
less portability. They require a deep knowledge of MCU and peripheral specifications.

The LL drivers are designed to offer a fast light-weight expert-oriented layer which is
closer to the hardware than the HAL. Contrary to the HAL, LL APIs are not provided for
peripherals where optimized access is not a key feature, or for those requiring heavy
software configuration and/or complex upper-level stack.

The LL drivers feature:

— Aset of functions to initialize peripheral main features according to the parameters
specified in data structures

— A set of functions used to fill initialization data structures with the reset values
corresponding to each field

—  Function for peripheral de-initialization (peripheral registers restored to their
default values)

— A set of inline functions for direct and atomic register access

—  Fullindependence from HAL and capability to be used in standalone mode
(without HAL drivers)

—  Full coverage of the supported peripheral features.
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2.1.3

2.2

2.2.1
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Basic peripheral usage examples

This layer encloses the examples build over the STM32 peripheral using only the HAL and
BSP resources.

Level 1

This level is divided into two sub-layers:
e Middleware components
e Examples based on the middleware components.

Middleware components

The middleware is a set of libraries covering FatFS. FreeRTOS™  USB Device, STMTouch
(STM32 touch sensing library), and STM32_WPAN middleware. Horizontal interactions
between the components of this layer is done directly by calling the feature APls while the
vertical interaction with the low-layer drivers is done through specific callbacks and static
macros implemented in the library system call interface. For example, the FatFS
implements the disk 1/O driver to access microSD™ drive.
The main features of each middleware component are as follows:
e  FAT file system

—  FatFS FAT open source library

—  Long file name support

—  Dynamic multi-drive support

— RTOS and standalone operation

—  Examples with microSD™
e FreeRTOS™

—  Open source standard

—  CMSIS compatibility layer

—  Tickless operation during low-power mode

3
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— Integration with all STM32Cube™ middleware modules
e  USB Device library
—  Support for several USB classes (Mass-Storage, HID, CDC, DFU, AUDIO and
MTP)
—  Support for multipacket transfer: large amount of data can be sent without splitting
the transfer into transactions of maximum size packets.
—  Use of configuration files to change the core and the library configuration without
changing the read-only library code.
— RTOS and standalone operation,
— Link with low-level driver through an abstraction layer using the configuration file,
to avoid any dependency between the library and the low-level drivers.
e  STM32 touch sensing library
Robust STMTouch capacitive touch sensing solution supporting proximity, touchkey,
linear and rotary touch sensor. It is based on a proven surface charge transfer
acquisition principle.
e  STM32 wireless personal area network middleware (STM32_WPAN) developed within
the STM32WB framework
—  BLE 5.0 certified stacks
—  BLE stack: link layer, HCI, L2CAP, ATT, SM, GAP and GATT database
(Declaration ID D042164, available from see https://launchstudio.bluetooth.com)
—  BLE multiprofile subsystem: a complete coverage of BLE software stack profiles
and services (Declaration ID D042214, available from
https://launchstudio.bluetooth.com)
- 802.15.4 Thread® v1.1 certified applications
The Thread® stack is provided by OpenThread, an open-source implementation of
the Thread® networking protocol (refer to https://openthread.io for more
information on this stack). The stack supports two configurations:
FTD (Full Thread Device), to be used for Leader, Router and End Device Thread
roles (except for Border Router).
MTD (Minimal Thread Device), to be used for End Device and Sleepy End Device
Thread roles.
— 802.15.4 MAC layer
This MAC APl is based on the latest official IEEE Std 802.15.4-2011 document
available from http://grouper.ieee.org
It supports Full Function Devices (FFD) and can ensure the role of Personal Area
Network (PAN) coordinator and Reduced Function Device (RFD) that serve as
node for extremely simple applications.
2.2.2 Examples based on the middleware components

3

Each middleware component comes with one or more examples (called also Applications)
showing how to use it. Integration examples that use several middleware components are
provided as well.
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2.3 Level 2

This level is composed of a single layer which consist in a global real-time and graphical
demonstration based on the middleware service layer, the low-level abstraction layer and
the basic peripheral usage applications for board based features.

3

12/29 UM2550 Rev 1




UM2550

STM32CubeWB firmware package overview

3

3.1

3

STM32CubeWB firmware package overview

Supported STM32WB devices and hardware

STM32Cube™ offers a highly portable hardware abstraction layer (HAL) built around a
generic architecture. It allows the build-upon layers, such as the middleware layer, to
implement their functions without knowing, in-depth, the MCU used. This improves the
library code re-usability and guarantees an easy portability on other devices.

In addition, thanks to its layered architecture, the STM32CubeWB offers full support of all
STM32WB Series. The user has only to define the right macro in stm32wbxx.h.

Table 1 shows the macro to define depending on the STM32WB device used. This macro
must also be defined in the compiler preprocessor.
Table 1. Macros for STM32WB Series
Macro defined in stm32wbxx.h STM32WB devices

STM32WB55CGU6, STM32WBS55CEUG, STM32WB55CCUG,
STM32WB55RGV6, STM32WB55REV6, STM32WB55RCV6,
STM32WB55VGY6, STM32WB55VEY6, STM32WB55VCY6,
STM32WB55VGQ6, STM32WB55VEQG, STM32WB55VCQ6

STM32WB55xx

STM32CubeWB features a rich set of examples and applications at all levels making it easy
to understand and use any HAL driver and/or middleware components. These examples run
on the STMicroelectronics boards listed in Table 2.

Table 2. Boards for STM32WB Series

Kit Supported boards

P-NUCLEO-WB55.Nucleo: STM32WB55RG
P-NUCLEO-WB55.USBDongle: STM32WB55CG

P-NUCLEO-WB55

The P-NUCLEO-WB55 kit contains two boards to demonstrate STM32WB connectivity
functionalities:

e a Nucleo-68 board: P-NUCLEO-WB55.Nucleo
e aUSB dongle: P-NUCLEO-WB55.USBDongle

The P-NUCLEO-WB55.Nucleo is compatible with Adafruit LCD display Arduino™ UNO
shields which embed a microSD™ connector and a joystick in addition to the LCD.

The Arduino™ shield drivers are provided within the BSP component. Their usage is
illustrated by a demonstration firmware.

The STM32CubeWB firmware is able to run on any compatible hardware. The user simply
updates the BSP drivers to port the provided examples on his own board, if this latter has
the same hardware features (LED, LCD display, buttons...).
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Firmware package overview

The STM32CubeWB firmware solution is provided in one single zip package having the
structure shown in Figure 3.

Figure 3. STM32CubeWB firmware package structure
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1. The components files must not be modified by the user. Only the \Projects sources are eligible to changes
by the user.
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For each board, a set of examples are provided with pre-configured projects for EWARM,

MDK-ARM, and SW4STM32 toolchains.

Figure 4 shows the project structure for the P-NUCLEO-WB55.Nucleo board.

Figure 4. Overview

of STM32CubeWB examples
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The examples are classified depending on the STM32Cube™ level they apply to, and are
named as explained below:

e Level 0 examples are called Examples, Examples_LL and Examples_MIX. They use
respectively HAL drivers, LL drivers and a mix of HAL and LL drivers without any
middleware component.

e Level 1 examples are called Applications. They provide typical use cases of each
middleware component.

The BLE folder contains typical BLE 5.0 use cases.

The Thread folder contains typical thread use cases.

The BLE Thread folder contains an application illustrating the switching from BLE to
Thread and vice-versa.

Templates projects available in the Templates and Templates_LL directories allow to quickly
build any firmware application on a given board.

All examples have the same structure:

e \Inc folder that contains all header files.

e \Srcfolder for the sources code.

. \EWARM, \MDK-ARM, and \SW4STM32 folders contain the pre-configured project for
each toolchain.

e readme.txt describing the example behavior and needed environment to make it
working

e  *joc file that allows users to open most of firmware examples within STM32CubeMX
(starting from STM32CubeMX 5.1)

3
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Getting started with STM32CubeWB

Running your first example

This section explains how simple is to run a first example within STM32CubeWB. It uses as
illustration the generation of a simple LED toggle running on P-NUCLEO-WB55.Nucleo
board:

1.

Download the STM32CubeWB firmware package. Unzip it into a directory of your
choice. Make sure not to modify the package structure shown in Figure 3. Note that it is
also recommended to copy the package at a location close to your root volume (e.g.
C\Eval or G:\Tests) because some IDEs encounter problems when the path length is
too long.

Browse to \Projects\NUCLEO-WB55-Nucleo\Examples.
Open \GPIO, then \GPIO_EXTI folders.

Open the project with your preferred toolchain. A quick overview on how to open, build
and run an example with the supported toolchains is given below.

Rebuild all files and load your image into target memory.

Run the example: each time you press the user pushbutton (SW1), LED2 toggles (for
more details, refer to the example readme file).

To open, build and run an example with the supported toolchains:, follow the steps below:

EWARM

a) Under the example folder, open \EWARM sub-folder
b) Launch the Project.eww workspace(b)

c) Rebuild all files: Project->Rebuild all

d) Load project image: Project->Debug

e) Run program: Debug->Go(F5)

MDK-ARM

a) Under the example folder, open \MDK-ARM sub-folder
b) Launch the Project.uvprojx workspace(b)

c) Rebuild all files: Project->Rebuild all target files

d) Load project image: Debug->Start/Stop Debug Session
€) Run program: Debug->Run (F5).

SW4STM32

a) Open the SW4STM32 toolchain

b) Click File->Switch Workspace->Other and browse to the SW4STM32
workspace directory

c) Click File->Import, select General->Existing Projects into Workspace and then
click Next

d) Browse to the SW4STM32 workspace directory and select the project

e) Rebuild all project files: select the project in the Project explorer window then
click the Project->build project menu

f)  Run program: Run->Debug (F11)
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Developing your own application

Using STM32CubeMX to develop or update your application

In the STM32CubeWB MCU Package, all Example projects are generated with the
STM32CubeMX tool to initialize the system, peripherals and middleware.

The direct use of an existing Example project from within STM32CubeMX requires
STM32CubeMX 5.1 or higher:

e Atfter the installation of STM32CubeMX, open and eventually update a proposed
project. The simplest way to open an existing project is to double-click on the *.ioc file
so that STM32CubeMX automatically opens the project and its source files.

e The initialization source code of such projects is generated by STM32CubeMX; the
main application source code is delimited by comments USER CODE BEGIN and USER
CODE END. In case of a modification of the IP selection and setting, STM32CubeMX
updates the initialization part of the code but preserves the main application source
code.

For developing an own project in STM32CubeMX, follow the step-by-step process:

1. Select the STMicroelectronics STM32 microcontroller that matches the required set of
peripherals.

2. Configure each required embedded software thanks to a pinout-conflict solver, a clock-
tree setting helper, a power consumption calculator, and the utility performing MCU
peripheral configuration (such as GPIO or USART) and middleware stacks (such as
USB).

3. Generate the initialization C code based on the configuration selected. This code is
ready to use within several development environments. The user code is kept at the
next code generation.

For more information about STM32CubeMX, refer to the STM32CubeMX user manual
(UM1718).

For a list of the Example projects available in STM32CubeWB, and their content, refer to the
STM32Cube firmware examples for STM32WB Series application note (AN5155).

b. The workspace name may change from one example to another.

3
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4.2.2 HAL application
This section describes the steps required to create your own HAL application using
STM32CubeWB:
1. Create your project
To create a new project, you either start from the Template project provided for each
board under \Projects\<STM32xxx_yyy>\Templates or from any available project under
\Projects\<STM32xxy_yyy>\Examples or \Projects\<STM32xx_yyy>\Applications
(where <STM32xxx_yyy> refers to the board name, such as P-NUCLEO-
WB55.Nucleo).
The Template project is providing empty main loop function, however it is a good
starting point to get familiar with project settings for STM32CubeWB. The template has
the following characteristics:
— It contains the source code of HAL, CMSIS and BSP drivers which are the minimal
components required to develop a code on a given board.
— It contains the include paths for all the firmware components.
— It defines the STM32WB device supported, thus allowing to configure the CMSIS
and HAL drivers accordingly.
— It provides read-to-use user files pre-configured as shown below:
HAL initialized with default time base with ARM Core SysTick.
SysTick ISR implemented for HAL Delay () purpose.
Note: When copying an existing project to another location, make sure to update the include

3

paths.
2. Add the necessary middleware to your project (optional)

The available middleware stacks are: FatFS, FreeRTOS™, USB Device, STMTouch
and STM32_WPAN. To know which source files must be added to the project file list,
refer to the documentation provided for each middleware. It is possible to look at the
applications available under \Projects\STM32xxx_yyy\Applications\<MW _Stack>
(where <MW _Stack> refers to the middleware stack, such as USB_Device) to know
which source files and which include paths must be added.

3. Configure the firmware components

The HAL and middleware components offer a set of build time configuration options
using macros # define declared in a header file. A template configuration file is
provided within each component, it has to be copied to the project folder (usually the
configuration file is named xxx_conf_template.h, the word ‘_template’ needs to be
removed when copying it to the project folder). The configuration file provides enough
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information to know the impact of each configuration option. More detailed information
is available in the documentation provided for each component.

4. Start the HAL Library

After jumping to the main program, the application code must call HAL Init () APl to
initialize the HAL Library, which do the following tasks:

a) Configuration of the Flash prefetch and SysTick interrupt priority (through macros
defined in stm32wbxx_hal_conf.h).

b) Configuration of the SysTick to generate an interrupt every millisecond at the
SysTick interrupt priority TICK INT PRIO defined in stm32wbxx_hal_conf.h.

c) Setting of NVIC Group Priority to 0.

d) Callof HAL MspInit () callback function defined in stm32wbxx_hal_msp.c user
file to perform global low-level hardware initializations.

5. Configure the system clock

The system clock configuration is done by calling the two APIs described below:

a) HAL RCC OscConfig(): this APl configures the internal and/or external
oscillators, as well as the PLL source and factors. The user chooses to configure
one oscillator or all oscillators. The PLL configuration can be skipped if there is no
need to run the system at high frequency.

b) HAL RCC ClockConfig(): this APl configures the system clock source, the
Flash memory latency and AHB and APB prescalers.

6. Initialize the peripheral

a) First write the peripheral HAL. PPP MspInit function. Proceed as follows:
- Enable the peripheral clock.
- Configure the peripheral GPIOs.
- Configure the DMA channel and enable DMA interrupt (if needed).
- Enable peripheral interrupt (if needed).

b) Edit the stm32xxx_it.c to call the required interrupt handlers (peripheral and DMA),
if needed.

c) Write process complete callback functions if you plan to use peripheral interrupt or
DMA.

d) In your main.c file, initialize the peripheral handle structure then call the function
HAL PPP Init () to initialize your peripheral.

7. Develop your application

At this stage, your system is ready and you start developing your application code.

—  The HAL provides intuitive and ready-to-use APIs to configure the peripheral. It
supports polling, interrupts and DMA programming model, to accommodate any
application requirements. For more details on how to use each peripheral, refer to
the rich examples set provided in the STM32CubeWB MCU Package.

—  If your application has some real-time constraints, you find a large set of examples
showing how to use FreeRTOS™ and integrate it with all middleware stacks
provided within STM32CubeWB. This is a good starting point to develop your
application.

In the default HAL implementation, SysTick timer is used as timebase: it generates
interrupts at regular time intervals. If HAL. Delay () is called from peripheral ISR process,
make sure that the SysTick interrupt has higher priority (numerically lower) than the
peripheral interrupt. Otherwise, the caller ISR process will be blocked. Functions affecting
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timebase configurations are declared as __ weak to make override possible in case of other
implementations in user file (using a general purpose timer for example or other time
source). For more details, refer to HAL, TimeBase example.

4.2.3 LL application

3

This section describes the steps needed to create your own LL application using
STM32CubeWB.

1.

Create your project

To create a new project you either start from the Templates_LL project provided for
each board under \Projects\<sSTM32xxx_yyy>\Templates_LL or from any available
project under \Projects\<STM32xxy_yyy>\Examples_LL (<STM32xxx_yyy> refers to
the board name, such as P-NUCLEO-WB55.Nucleo).

The Template project provides an empty main loop function, however it is a good
starting point to get familiar with project settings for STM32CubeWB.

Template main characteristics are the following:

— It contains the source codes of the LL and CMSIS drivers which are the minimal
components needed to develop code on a given board.

— It contains the include paths for all the required firmware components.

— It selects the supported STM32WB device and allows to configure the CMSIS and
LL drivers accordingly.

— It provides ready-to-use user files, that are pre-configured as follows:
main.h: LED & USER_BUTTON definition abstraction layer.
main.c: System clock configuration for maximum frequency.

Port an existing project to another board

To port an existing project to another target board, start from the Templates_LL project
provided for each board and available under
\Projects\<STM32xxx_yyy>\Templates_LL:

a) SelectaLL example

To find the board on which LL examples are deployed, refer to the list of LL
examples STM32CubeProjectsList.html or to application note “STM32Cube
firmware examples for STM32WB Series” (AN5155).

b) Port the LL example

—  Copy/paste the Templates_LL folder - to keep the initial source - or directly update
existing Templates_LL project.

—  Then porting consists principally in replacing Templates_LL files by the
Examples_LL targeted project.

—  Keep all board specific parts. For reasons of clarity, board specific parts have been
flagged with specific tags:

========== ==== BOARD SPECIFIC CONFIGURATION CODE BEGIN

============== BOARD SPECIFIC CONFIGURATION CODE END
Thus the main porting steps are the following:

— Replace the stm32wbxx_it.h file

— Replace the stm32wbxx_it.c file

— Replace the main.h file and update it: keep the LED and user button definition of
the LL template under ‘BOARD SPECIFIC CONFIGURATION tags.
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— Replace the main.c file and update it:

Keep the clock configuration of the SystemClock Config() LL template
function under ‘BOARD SPECIFIC CONFIGURATION’ tags.

Depending on LED definition, replace each LEDx occurrence with another LEDy
available in main.h.

Thanks to these adaptations, the example should be functional on the targeted board.

424 Installing and running the STM32CubeUpdater program

Follow the sequence below to install and run the STM32CubeUpdater:
1. To launch the installation, double-click the SetupSTM32CubeUpdater.exe file.
2. Accept the license terms and follow the different installation steps.

3. Upon successful installation, STM32CubeUpdater becomes available as an
STMicroelectronics program under Program Files and is automatically launched. The
STM32CubeUpdater icon appears in the system tray. Right-click the updater icon and
select Updater Settings to configure the Updater connection and whether to perform
manual or automatic checks. For more details on Updater configuration, refer to
section 3 of STM32CubeMX user manual (UM1718).

3
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3

How to flash the wireless coprocessor binary

The STM32CubeWB firmware package contains several wireless stack binaries located
under Projects\STM32WB_Copro_Wireless_Binaries.
The supported binaries are the following:
e  stm32wbbx_BLE_Stack_fw.bin
Full BLE stack, certified 5.0: link layer, HCI, L2CAP, ATT, SM, GAP and GATT database
BT SIG certificate: declaration ID D042164
e stm32wbbx_BLE HCILayer fw.bin
HCI layer, only mode 5.0 certified: link layer and HCI
BT SIG certification listing: declaration ID D042213
e stm32wbbx_Thread_FTD_fw.bin
Full Thread Device, certified v1.1

Usage: Leader, Router and End Device Thread roles (full featured except for Border
Router)

e  stm32wb5x_Thread MTD_fw.bin

Minimal Thread Device, certified v1.1.

Usage: End Device and Sleepy End Device Thread roles
e  stm32wbb5x_BLE Thread fw.bin

Static Concurrent Mode BLE Thread, supporting full BLE stack certified 5.0 and Full
Thread Device certified v1.1

e stm32wbbx_Mac_802_15 4 fw.bin
MAC API based on the latest official IEEE Std 802.15.4-2011
Usage: MAC FFD and RFD devices

Follow the steps below to flash the wireless coprocessor binary into the device memory:

1. Install STM32CubeProgrammer version 1.4 or higher (refer to
“STM32CubeProgrammer software description” (UM2237)

The STM32CubeProgrammer software is available as command line interface (CLI).
It gives access to the firmware upgrade service (FUS) through the bootloader.
2. Set the device in bootloader mode
This is achieved by connecting BOOTO pin to Vpp.
For P-NUCLEO-WB55.Nucleo:
a) Add ajumper between CN7.5 (Vpp) and CN7.7 (BOOTO).
b) Power on the board via USB_USER and J2 jumper (USB_MCU).
For P-NUCLEO-WB55.USBDongle:
a) Move SW2 switch to BOOTO position.
b) Connect P-NUCLEO-WB55.USBDongle to you PC USB port.
3. Delete the current wireless stack by executing the following command line
STM32_ Programmer CLI.exe -c port=usbl -fwdelete
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Download the new wireless stack

Each binary version must be installed at a different address provided in
Projects\STM32WB_Copro_Wireless_Binaries\Release_Notes.html.

STM32_ Programmer CLI.exe -c port=usbl -fwupgrade
Wireless Coprocessor Binary] [Install address] firstinstall=1

where
[Wireless_Coprocessor_Binary] corresponds to the location of the binary

[Install address] corresponds to the value indicated in the
Projects\STM32WB_Copro_Wireless_Binaries\Release Notes.html and
depending on the selected binary and version.

Go to step 2) to put back device in Normal mode.

For P-NUCLEO-WB55.Nucleo:

a) Remove the jumper between CN7.5 (Vpp) and CN7.7 (BOOTO).
b) Power on the device through the ST-LINK connector.

For P-NUCLEO-WB55.USBDongle:

a) Move SW2 switch to "lO" position.

3

UM2550 Rev 1




UM2550

FAQ

6

6.1

6.2

6.3

6.4

3

FAQ

What is the license scheme for the STM32CubeWB
firmware?

The HAL is distributed under a non-restrictive BSD (Berkeley Software Distribution) license.

The middleware stacks made by STMicroelectronics (USB Device Libraries, STemWin,
STM32_WPAN) come with a licensing model allowing easy reuse, provided it runs on an
STMicroelectronics device.

The middleware based on well-known open-source solutions (FreeRTOS™ and FatFS)
have user-friendly license terms. For more details, refer to the license agreement of each
middleware.

What boards are supported by the STM32CubeWB firmware
package?

The STM32CubeWB firmware package provides BSP drivers and ready-to-use examples
for the following STM32WB boards:

e P-NUCLEO-WB55.Nucleo

e P-NUCLEO-WB55.USBDongle

Are any examples provided with the ready-to-use toolset
projects?

Yes. STM32CubeWB provides a rich set of examples and applications. They come with the
pre-configured projects for IAR™, Keil® and GCC-based toolchains.

Is there any link with Standard Peripheral Libraries?

The STM32Cube™ HAL and LL drivers are the replacement of the standard peripheral

library:

e The HAL drivers offer a higher abstraction level compared to the standard peripheral
APIs. They focus on peripheral common features rather than hardware. Their higher
abstraction level allows defining a set of user-friendly APls that are easily portable from
one product to another.

e The LL drivers offer low-layer APIs at registers level. They are organized in a simpler
and clearer way than direct register accesses. LL drivers also include peripheral
initialization APls, which are more optimized compared to what is offered by the SPL,
while being functionally similar. Compared to HAL drivers, these LL initialization APIs
allows an easier migration from the SPL to the STM32Cube™ LL drivers, since each
SPL API has its equivalent LL API(s).
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6.5 Does the HAL layer take benefit from interrupts or DMA?
How can this be controlled?

Yes. The HAL layer supports three API programming models: polling, interrupt and DMA
(with or without interrupt generation).

6.6 How are the product/peripheral specific features managed?
The HAL drivers offer extended APls, i.e. specific functions as add-ons to the common API
to support features available on some products/lines only.

6.7 How can STM32CubeMX generate code based on embedded
software?

STM32CubeMX has a built-in knowledge of STM32 microcontrollers, including their
peripherals and software, that allows to provide a graphical representation to the user and
generate *.h/*.c files based on user configuration.

6.8 When should | use HAL versus LL drivers?

HAL drivers offer high-level and function-oriented APIs, with a high level of portability.
Product/IPs complexity is hidden for end users.

LL drivers offer low-layer APIs at registers level, with a better optimization but less
portability. They require a deep knowledge of product/IPs specifications.

6.9 How can |l include LL drivers in my environment?

Is there any LL configuration file as for HAL?
There is no configuration file. Source code shall directly include the necessary
stm32wbxx_Il_ppp.h file(s).

6.10 Can | use HAL and LL drivers together? If yes, what are the

26/29

constraints?

It is possible to use both HAL and LL drivers. One handles the IP initialization phase with
HAL and then manages the 1/O operations with LL drivers.

The major difference between HAL and LL is that HAL drivers require to create and use
handles for operation management while LL drivers operates directly on peripheral
registers. Mixing HAL and LL is illustrated in Examples_MIX example.

3
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6.11 Are there any LL APIs which are not available with HAL?

Yes, there are.

A few Cortex® APIs have been added in stm32wbxx_Il_cortex.h , for instance for accessing
SCB or SysTick registers.

6.12 Why are SysTick interrupts not enabled on LL drivers?

When using LL drivers in standalone mode, you do not need to enable SysTick interrupts
because they are not used in LL APlIs, while HAL functions requires SysTick interrupts to
manage timeouts.

6.13 How are LL initialization APIls enabled?

The definition of LL initialization APls and associated resources (structure, literals and
prototypes) is conditioned by the USE_FULL_LIL_DRIVER compilation switch.

To be able to use LL APIs, add this switch in the toolchain compiler preprocessor.

3
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